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About This Book

This book, the VMware vCenter AppSpeed User’s Guide, describes the user interface for the VMware® vCenter
AppSpeed virtual machine and plug-in.

Intended Audience

This book is intended for IT administrators who use AppSpeed to monitor the performance, usage, and
dependencies of multitier applications running across both virtual and physical infrastructure.

This document assumes a basic understanding of VMware management and the VMware VI Client.

Document Feedback

VMware welcomes your suggestions for improving our documentation. If you have comments, send your
feedback to docfeedback@vmware.com.

Technical Support and Education Resources

The following sections describe the technical support resources available to you. To access the current versions
of this book and other books, go to http://www.vmware.com/support/pubs.

Online and Telephone Support

Use online support to submit technical support requests, view your product and contract information, and
register your products. Go to http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support for the fastest response on
priority 1 issues. Go to http://www.vmware.com/support/phone_support.

Support Offerings
Find out how VMware support offerings can help meet your business needs. Go to
http://www.vmware.com/support/services.

VMware Professional Services

VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials
designed to be used as on-the-job reference tools. Courses are available onsite, in the classroom, and live
online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides
offerings to help you assess, plan, build, and manage your virtual environment. To access information about
education classes, certification programs, and consulting services, go to http://www.vmware.com/services.
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AppSpeed Overview

VMware vCenter AppSpeed provides performance management and service-level reporting for applications
running within virtual appliances. AppSpeed analyzes the traffic that flows between end users, Web applications,
and back-end servers. This analysis provides visibility into multitier applications and enables you to rapidly
identify performance issues originating from inadequate resource allocation and application problems.

AppSpeed probes capture traffic to and from the servers on which the probes are deployed on the network.
This enables AppSpeed to monitor the real-time end user experience for all transaction requests, breaking
down performance from tier to tier. AppSpeed only monitors the traffic on those servers on which AppSpeed
probes are deployed.

AppSpeed establishes baselines based on application behavior and compares real-time metrics to service-level
targets. In addition, AppSpeed maintains historical monitoring data that you can use to analyze trends over
time and for troubleshooting purposes. You can identify which component is responsible for a performance
issue and identify the likely solution. You can also configure AppSpeed to generate real-time events in
response to transaction-level performance and availability issues. Optionally, email notifications can be sent
when events are generated.

AppSpeed includes a wide range of predefined viewing options to facilitate the analysis of performance data.
The predefined views incorporate different combinations of data, presented in both tabular and graphic format.
Different sets of views are available according to the type of object selected (application, server, or transaction).

Access the AppSpeed User Interface

You access AppSpeed from within the VMware vSphere Client or VMware Virtual Infrastructure (VI) Client.

NOTE The first time you access the user interface, AppSpeed prompts you to install the probes. See “Install
an AppSpeed Probe” on page 28.

To access the AppSpeed user interface
1 In the vSphere Client, click Home > Solutions and Applications and click the AppSpeed icon.

In the VI Client, click the AppSpeed icon on the toolbar.

If the AppSpeed icon does not appear, verify that the AppSpeed plug-in is selected in the Plugins menu.
2 Select the tab for the required AppSpeed module:

B Analysis: Enables you to view real-time and historical performance data.

B Map: Enables you to view the location of a specific application, server, or transaction on your network
topology map, as well as the relationships between the monitored objects. The default map view focuses
on applications, showing the connections between applications and the servers on which they operate.

B Administration: Enables you to perform various administrative functions, including installing and
deploying probes, configuring SSL keys and mail notification settings, and adding or editing
AppSpeed license keys.

VMware, Inc. 9
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Viewing Performance Data

This chapter describes how to display performance data for applications, servers, and transactions in the
Analysis module, and outlines the types of data presented in each of the predefined views.

This chapter includes the following topics:

B “About Views” on page 11

B “View Summary Data for Applications and Servers” on page 15
B “View Application Data” on page 16

B “View Server Data” on page 17

B “View Transaction Data” on page 17

B “Performance Indicators” on page 17

About Views

The AppSpeed Analysis module has several predefined views that enable you to view different cross-sections
of performance data in a variety of ways.

For details on the indicators displayed by each of the predefined views, see “Performance Indicators” on
page 17.

Select an Object
The AppSpeed inventory tree lists the applications and servers detected on the network.

If you select the root directory, the information displayed reflects the overall status of all of the applications
and servers. To display information for a specific application or server, select the object in the inventory tree.
Select a View

The available views vary according to the type of object selected on the AppSpeed inventory tree.

On the Analysis page, select the name of the view from Analysis Views drop-down menu.

Defining the Time Period and Resolution for Data Collection

Define the Time Frame

You can define the time period for which performance data is displayed. You can specify the start and end
times and dates, or you can view data for a time period, such as the previous month. You can also display the
data in specific units of time, such as weekly or hourly.

VMware, Inc. 1"
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To define a specific date

1 From the Select Time Frame drop-down menu in the view settings bar, select Manual.
2 Click From to specify the start date and time.

3 Select the start date and click OK.

4  Click To to specify the end date and time.

5  Select the end date and click OK.

The time frame of the data displayed is adjusted accordingly.

To define a time period
Under Select Time Frame in the view settings bar, select the time period from the drop-down menu.

For example, to view performance data for the past 12 hours, select Last 12 Hours.

Set the Time Resolution

You can set the time resolution of the displayed data, meaning that you can view the breakdown of data
according specific units of time, such as by week, day, hour, or minute. For example, an hourly time resolution
graphs the data across the hours of a day (0 to 23).

To set the time resolution

1 Under Select Time Frame in the view settings bar, click By.

2 From the drop-down men, select the time unit.

For example, an hourly time resolution graphs the data across the hours of a day (0 to 23).

If data is not available for the selected time unit, AppSpeed sets the largest unit available for the selected time
frame.

View Real-Time Metrics

You can view real-time metrics for the selected objects in the Info Panel. The types of information displayed
vary according to the object type. The data displayed reflects the performance for the past five minutes.

In the Applications and Servers view, the Info Panel displays the throughput and the level of SLA compliance.
It might also include information on the number of applications, servers, or transactions and their respective
latency and SLA states.

To display the Info Panel, click Show Info Panel in the upper right corner of the main display area.

To hide the Info Panel, click Hide Info Panel in the upper right corner of the main display area.

Performance Tables

One way to view performance data is in tables. The tables displayed depend on the selected view and object
type (application or server).

Each table is displayed on a separate tab. A dedicated row appears at the bottom of each tab, showing
summary data for the object selected on the inventory tree. This row does not change from tab to tab.

The following icons appear adjacent to the object name and indicate if the item is selected in the table:
|2 The item is selected.

|_| The item is not selected.

You can perform a variety of actions on the tabular display data:

B View data on the chart for specific applications, servers, or transactions.

®m  Drill down a specific application, server, or transaction to view additional data.

12 VMware, Inc.
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B Sort the table.
B Search for specific applications or servers.
®  Highlight the data for a specific object on the corresponding graph, by selecting its row in the table.

®  Export the data into a CSV file.

Sort Tabular Data

You can sort tabular data according to a specific parameter.

To sort data:
1  Click the corresponding column header.

2 Click again to reverse the sort order.

Search for Objects in a Table

You can search for objects in a table. The search criteria are applied to all cells in the displayed table.

To search for an object
1  In the tabular display pane, click &, .
2 In the Search text box, enter your search criteria and click &,.
The objects that match the search criteria are highlighted in the table.

3 To navigate between the results, click @® to move to the next entry or click @ to move to the previous
entry.

4 To cancel the search and clear the highlighting of table entries, click the Clear button.

NOTE To show or hide the search bar, click & .

Performance Charts and Graphs
The graphs and charts displayed depend on the selected view and object type.
You can perform a variety of actions from the graphic display pane:
m  Filter the displayed data.
B Show or hide latency standard deviation indicators on the graph.

®  Export the graph or the graph data.

Chart and Graph Types

The following graphs and charts are available:

Table 2-1. Charts and Graph Types

Chart/Graph Type Description
Availability Reports trends in error behavior for the selected period of time and selected object type.
Baseline Comparison Shows the average usage and latency for either applications or servers, with the

corresponding baseline (Applications and Servers view only).

Latency Displays the latency behavior during a selected period of time.

Latency Breakdown Reports the end-to-end latency breakdown in a chart for the selected application or
transaction. The content of this chart is not linked to your selections in the tabular display
area.

Usage vs. Latency Compares the latency and usage behaviors for the selected object type.

VMware, Inc. 13
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Table 2-1. Charts and Graph Types (Continued)

Chart/Graph Type Description

Throughput Breakdown  Reports the breakdown of throughput for servers for the selected application or transaction.
of Servers

Usage Reports the utilization during the selected period of time for the objects selected in the

display area.

For details on the performance indicators shown in each of the charts and graphs, see “Performance
Indicators” on page 17.

Filter the Graphic Display

You can view data for specific objects in the chart or graph.

To filter the data, select or deselect the check boxes in the table in the lower portion of the data display pane.

NOTE You cannot filter the latency breakdown and throughput breakdown graphs.

Display or Hide Latency Standard Deviation Indicators

Latency indicators, sometimes referred to as “whiskers,” illustrate the standard deviation for latency on
graphs in some of the views. By default, this feature is turned off.

To display or hide latency standard deviation indicators
In the tabular display pane, click @
You can view the standard deviation values in tooltips.

Click @ again to hide the latency indicators.

Exporting Performance Data

You can save performance data in other formats for further viewing and analysis in external applications.

Export Table or Graph Data

You can export performance data into a comma-separated value (CSV) file.
To export the data

1  Inthe tabular display pane, click @

2 Name the file and select the location, and click Save.

Export a Graph as an Image

You can save the currently displayed graph as an image (PNG).

To export the graph as an image

1  In the tabular display pane, click [,

2 Name the file and select the location, and click Save.

To export the graph data

1  In the tabular display pane, click [csi].

2 Name the file and select the location in which you want to save the file, and click Save.

The date is saved in a CSV file in the specified location.
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View Summary Data for Applications and Servers

You can view summary performance data for all the applications and servers on the network in one several
predefined views.

To view summary data for the entire network
1 On the AppSpeed inventory tree, select Applications and Servers (the root node).

The data shows the performance of all the applications and servers monitored by AppSpeed, according
to the Applications: Baseline Comparison view.

2 To view the total number of servers and applications, and the throughput and level of SLA compliance,
click the Analysis page to view the Info Panel.

The data displayed reflects the performance for the last five minutes.
3  (Optional) Select a different view from the Analysis Views drop-down menu.

4  (Optional) To view summary data in the graphic display pane for only some of the applications or servers,
deselect the check boxes for the objects for which you do not want to include data.

View Real-Time States

You can view the real-time values of performance indicators for all applications or for the transactions of a
selected application based on their performance in the last 10 seconds.

The tabular display pane of the States page lists the following state-related parameters:
B State: Current state of the application or transaction.

B Latency state: SLA state for latency.

B Error state: SLA state for errors.

B Average latency: Average measured time between the start of the client request to the end of the server
reply since the onset of the current state.

B Average errors: Average rate of errors since the onset of the current state.
B Average hits: Average number of hits per second since the onset of the current state.

B Since: Time when the state change occurred.

To view real-time state data
Click States on the page selection bar.

To view the States page, you must select Applications and Servers or a specific application on the inventory tree.

View Unmapped Traffic

You can view the unmapped servers and transactions detected on the network. Unmapped objects have not
yet been mapped to specific servers or applications.

NOTE The number of unmapped objects typically decreases as AppSpeed maps the environment.

To view unmapped traffic
1 In the navigation tree, select Applications and Servers.
2 Click Unmapped Traffic on the page selection bar.

You must configure the SSL keys for each endpoint where AppSpeed detects SSL traffic in order to view
unmapped traffic on HTTP sites that incorporate SSL protection. See “Managing SSL Keys” on page 31.
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3 View the status information for the unmapped traffic.

Name: Name of the server or transaction.
Endpoint: IP address and ports used by the server (Servers tab only).
Latency: Average and standard deviation (STDEV) latency rates for the server or transaction.

Hits: Average number of hits per second for the server or transaction, and the total number of hits in
the specified timeframe.

Throughput: Average throughput for the server or transaction, and the total throughput in the
specified timeframe.

Errors: Average rate of errors, as a percentage, for the server or transaction.

View Application Data

You can view information on a specific applications, such as its properties, threshold settings, real-time states,
and generated events.

To display detailed data for a single application

1  Select the application in the navigation pane.

The data display pane displays data based on the Usage vs. Latency view.

NOTE To return to the previous data display, click the Back icon on the toolbar.

2 (Optional) To change the application view, select a view from the Analysis Views drop-down menu.

View Application States

You can view real-time metrics for the selected application, including throughput, hits, latency, errors, and
SLA levels in the Analysis page Info Panel. The data displayed reflects the performance for the last five

minutes.

Table 2-2 describes the icons used to represent the application states.
Table 2-2. State Icons

Icon

Description

The application’s performance complies with set SLA and latency thresholds.

The application is in Warning state.

The application does not comply with the terms of the SLA.

The application is not available.

View Application Properties

You can view the general properties of the selected application, including its name and application roots.

To view/edit the application properties

On the page selection bar, click Properties.

Edit Application Properties

You can edit the name of the application.

To edit the application name

1  On the page selection bar, click Properties.

2 Edit the text in the Name text box and click Update.

16
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View Server Data

You can view performance analysis data for a server and its related objects (servers, applications, and
dependent servers), including charts and tables.

To display detailed data for a single server

1

Select the server in the navigation pane.

The data display pane displays data based on the Usage vs. Latency view.

NOTE To return to the previous data display, click the Back icon on the toolbar.

(Optional) To change the server view, select a view from the Analysis Views drop-down menu.

View Transaction Data

You can view transaction data, such as its properties and events generated.

To display transaction information

1
2

In the navigation pane, select the application for which you want to view a transaction.
In the tabular data pane, select the Transactions tab.

The data display pane display data based on the Usage vs. Latency view.

NOTE To return to the previous data display, click the Back icon on the toolbar.

(Optional) To change the transaction view, select a different view from the Analysis Views drop-down
menu.

To view information about the transaction, such as its name, transaction roots or the or the application to
which it belongs, click Properties on the page selection bar.

NOTE The full name of the transaction varies according to transaction type; for example, a URL is
displayed for an HTTP transaction, whereas a full database query is displayed for a database transaction.

Performance Indicators

AppSpeed monitors the following performance indicators. The performance indicators displayed vary

according to the selected view.

Table 2-3. AppSpeed Performance Indicators

Performance Indicator Description

Average Latency Measured time between the start of the client request to the end of the server reply,
averaged across all hits in the given time frame. A larger value means a slower server
response.

Average Reply Size Average size, in bytes, of a single server reply, averaged across all hits in the given time
period.

Average Throughput Average number of reply bytes per second in the given time period.

Error Percentage Percentage of error hits as a portion of the total hits in the given time period.

Execution Time Sum of all latencies in the given time frame. This value reflects the total amount of time

of all server replies in the given time frame.

Hit Rate Average number of hits per second in the given time frame.

Latency Baseline Average latency of all hits in the last year.
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Table 2-3. AppSpeed Performance Indicators (Continued)
Performance Indicator Description

Latency Breakdown ®m  Application: The latency measured from the time the server receives the first packet
of the request until it starts to transmit the reply.

®  Infrastructure: The latency measured from the time the server starts transmitting the
reply until fully replying to the client's request.

Network (RTT): The average round-trip time, without failures, from client to server.
®  Network Overhead: The cost of packet retransmissions, errors and drops.

Latency STDEV The standard deviation of the latency of all the hits in the given time frame.

Max. Latency The latency of the slowest hit in the given time frame.

SLA percentage The percentage of hits that were not errors and which had latency within SLA levels.
Total Errors The total number of hits identified as errors in the given time frame.

Total Hits The total number of hits in the given time frame.

Total Throughput The total number of reply bytes in the given time frame.

Indicators by View
The type of object selected on the AppSpeed inventory tree determines the available views and the
performance indicators included in each view.
Performance Indicators in Applications and Servers Views

Table 2-4 lists the performance indicators included in the views available when Applications and Servers is
selected on the AppSpeed inventory tree.

NOTE A plus (+) sign indicates that the performance indicator is shown in the view.

Table 2-4. Performance Indicators in Applications and Servers Views

View Name

Applications:  Applications: Servers:
Performance Baseline Usage Over Baseline Servers: Servers to Applications
Indicator Comparison Time Comparison Least Used Applications to Servers
Average + + + + +
Latency
Latency + +
Baseline
Latency + + + +
STDEV
Hit Rate + + + + + +
Total Hits + + + + + +
Average + + + + + +
Throughput
Total + + + +
Throughput
Average + +
Reply size
Endpoint + +

18 VMware, Inc.



Chapter 2 Viewing Performance Data

Performance Indicators in Application Views

Table 2-5 lists the performance indicators included in the views available when an application is selected in the
AppSpeed inventory tree.

NOTE A plus (+) sign indicates that the performance indicator is shown in the view.

Table 2-5. Performance Indicators in Application Views

View Name

Most Throughput
Performance Usagevs. Slowest Latency Latency Used Usage Breakdown  Availability
Indicator Latency Transact. Over Time Breakdown Transact. Over Time of Servers Over Time

Average + + + + + + + +
Latency

Latency + + + + +
STDEV

Max Latency + + + +

Hit Rate + + + + +

Total Hits + + + + + + +

Average + + + + +
Throughput

Total + + + +
Throughput

Total Errors +

Error + + +
Percentage

Execution
Time

Average + + + + +
Reply Size

Application +

Infra- +
structure

Network +
(RTT)

Network +
Overhead
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Performance Indicators in Server Views

Table 2-6 lists the performance indicators included in the views available when a server is selected on the
AppSpeed inventory tree.

NOTE A plus (+) sign indicates that the performance indicator is shown in the view.

Table 2-6. Performance Indicators in Server Views

Performance
Indicator

Average Latency

Usage vs.
Latency

+

Applications
Latency

+

View Name

Latency
Breakdown

+

Applications
Usage

+

Applications
Availability

+

Latency STDEV

+

+

+

Max Latency

Hit Rate

Total Hits

Average
Throughput

Total Throughput

Total Errors

Error Percentage

Execution Time

Average Reply Size

Application

Infrastructure

Network (RTT)

Network Overhead

Performance Indicators in Transaction Views

Table 2-7 lists the performance indicators included in the views available when a transaction is selected on the
AppSpeed inventory tree.

NOTE A plus (+) sign indicates that the performance indicator is shown in the view.

Table 2-7. Performance Indicators in Transaction Views

View Name
Performance Usage vs. Latency Over Latency Usage Over Availability
Indicator Latency Time Breakdown Time Over Time
Average Latency + + + + +
Latency STDEV + + +
Max Latency + + +
Hit Rate + + +
Total Hits + + + +
Average Throughput + + +
Total Throughput +
Total Errors +
Error Percentage + + +
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Table 2-7. Performance Indicators in Transaction Views (Continued)

View Name
Performance Usage vs. Latency Over Latency Usage Over Availability
Indicator Latency Time Breakdown Time Over Time
Execution Time +
Average Reply Size + + + +
Application +
Infrastructure +
Network (RTT) +
Network Overhead +
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Working with the Topology Map

This topology map shows the relationships between the applications and servers detected on the network, as
well as the dependencies between applications.

This chapter includes the following topics:
m  “Display the Topology Map” on page 23
B “Topology Map” on page 24

Display the Topology Map

You can view the default map by selecting the Map module. Alternatively, while viewing application or server
data in the Analysis module, you can directly access the map, which in turn focuses on the selected object.

To display the topology map

®m  Click the Map tab. By default, the map view focuses on applications.

To display the topology map from an application view
B In the Info Panel, click the Find Application on Topology Map link.
The selected application is centered on the topology map.

By default, the Application Focused view is selected.

To display the topology module from a server view
®  In the Info Panel, click the Find Application on Topology Map link.
The selected application is centered on the topology map.

By default, the Server Focused view is selected.

Select Map View
The Topology Map can be displayed in either of the following viewing modes:

m & Application Focused: Applications are centered and lines are drawn from each application to its
servers.

m ¥ Server Focused: Servers are centered and lines are drawn from each server to its applications.

To select a view, select the corresponding option on the map toolbar.

VMware, Inc. 23
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Topology Map
The topology map is displayed in the Map module and includes application and server objects.
The following object types are represented on the topology map:
b Application (the type of application appears below the icon)
511 Server (the IP address of the server appears below the icon)
The SLA state of each application is indicated by the appearance of additional icon:
@ Warning
Above SLA
Not available
The absence of an additional icon indicates that the state is OK.

Lines indicate the relationships between applications and servers, based on the selected map view. If the view
focuses on applications, then each application is centered with lines connecting it to the servers on which the
application runs. If the view focuses on servers, each server is centered and lines connect it to the applications
run on it. Dependencies are indicated by dashed orange lines.

Viewing Dependencies

You can view the dependencies between objects on the map. The type of relationships displayed depends on
the object at the center of the map. Dependencies are indicated by dashed orange lines.

B When the focus is on an application, showing the dependencies displays the connections between the
different applications.

B When the focus is on a server, showing the dependencies displays the connections between the different
servers.

To display the object dependencies, select the Show Dependencies check box.

To hide the object dependencies, clear the Show Dependencies check box.

Overview Map Window

The Overview Map window displays a miniature view of the map area. It enables you to select and zoom in
on a specific area on the map, or adjust the overall scale of the map by zooming in and out.

To view the topology map using the Overview Map window.
1  Select the Show Overview map check box.
To hide the Overview Map window, clear the Show Overview Map check box.

2 To focus on a specific area, select the area and drag the selection box around the relevant area in the
miniature map.

3 Tozoom in, click ) on the map scale bar.
To zoom out, click (=) on the map scale bar.

4  To adjust the zoom to fit the content, click b3 on the map scale bar.
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Analyze an Object
You can select an object on the topology map and view its details in the Analysis page.
To display the analysis information for a map object
1 Select the object on the topology map.
2 Click @) Analyze.

The Analysis page for the selected application or server is displayed.

Locate an Object on the Map
You can search for an object on the topology map.
To locate an object on the map
B Type the name of the object (or part of it) in the text box and click fgl
The first object that matches is selected on the map.

To locate the next object that matches the name, click Show Next.
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AppSpeed Administration

You can perform various administrative functions in AppSpeed, including adding and deleting the probes that
AppSpeed uses to monitor vSwitches, configuring SSL keys and mail notification settings, and adding or
editing AppSpeed license keys.

This chapter includes the following topics:

B “Managing Probes” on page 27

B “Configuring AppSpeed with vNetwork Distributed Switching” on page 29
B “Managing SSL Keys” on page 31

B “Managing AppSpeed Licenses” on page 33

Managing Probes

Before the monitoring process can begin, you must install at least one AppSpeed probe on one or more hosts.
Each probe can monitor up to three vSwitches. You can install more than one probe on the same host to
monitor additional vSwitches.

You initially configure the probe settings, including the management network, storage device, and specific
vSwitches to monitor, as part of the probe installation process. After that, you can add and remove probes as
needed.

NOTE To configure the AppSpeed probe to monitor a vNetwork distributed switch, see “Configuring
AppSpeed with vNetwork Distributed Switching” on page 29.

Viewing Probe Information

You can view the current probe configuration details.

To view probe information

1  Click the Administration tab at the top of the AppSpeed user interface to display the Administration
module.

2 In the navigation pane, click Probe Management.

The Probe Management window displays the existing host clusters and hosts and the probes installed on
them in a hierarchical format.
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Install an AppSpeed Probe

You can install a probe on one host at a time, or you can install a probe on multiple hosts at the same time.

To install a probe

1

In the Probe Management window, select the check box for one or more hosts or clusters on which to
install a probe and click Install Probe.

A probe is installed on each selected host, regardless of whether another probe is already installed on the
host.

NOTE When you select the check box for a cluster, the check boxes for each host that it contains are
selected. Similarly, when you select a host, any probes already installed on it are selected.

The Probe Installation window displays a separate entry for each host that you select. Each entry appears
in a separate pane.

NOTE When you install a probe in AppSpeed, distributed vSwitches do not appear in the Probe
Installation window. To monitor these switches, you must configure the AppSpeed probe. See
“Configuring AppSpeed with vNetwork Distributed Switching” on page 29.

(Optional) Configure the probe for each host entry.

a  Type the name of the probe in the Probe Name text box.
If you do not specify a name, the AppSpeed server assigns a default name.

b  From the Storage drop-down menu, select the storage device to which the probe connects.

¢ From the Management Network drop-down menu, select the network to use to manage the probes:
m  Select DHCP to use dynamic address settings.

B Select Static IP to set a fixed IP address for the network management card. Enter the IP address
and netmask details. Optionally, enter the gateway details.

B Select up to three monitoring vSwitches. The vSwitches sniff traffic on the configured
management network. By default, the first three available vSwitches are selected.

(Optional) To add an additional probe to a host, click ! Install another probe on this host at the bottom
of the host entry and configure the probe as described in Step 2.

When you are done adding host-probe combinations, click Install Probes.

Review the installation information, and click OK.

Alternatively, click Back to return to change any of the settings.

The installation progress is indicated in the Probe Status column in the Probes Management window.

Upon completion, the new probe is added to the All Probes folder in the VI client. The probe is powered
on and set up.

Power Probes On or Off

You can power probes on or off from the Probe Management window.

To power probes on or off

In the Probes Management window, select the check boxes for one or more probes, and click Power On or
Power Off.
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Delete Probes

If you do not want to monitor the traffic on a specific host, you can remove the probes from that host.

To delete probes from hosts

1

In the Probes Management window, select the check boxes for one or more probes on the same or multiple
hosts, and click Delete Probe.

Click OK to confirm.

The probe is removed from the selected hosts only.

Configuring AppSpeed with vNetwork Distributed Switching

When you install a probe in AppSpeed the distributed switches do not appear in the Probe Installation
window. You must manual configure AppSpeed to monitor these switches.

This chapter includes the following topics:

“Configuring AppSpeed to Monitor a vNetwork Distributed Switch” on page 29
“Configuring AppSpeed to Monitor Cisco Nexus 1000V Switches” on page 30

Configuring AppSpeed to Monitor a vNetwork Distributed Switch

If only vNetwork Distributed Switches are configured in the vCenter or if all other vSwitches are already being
monitored by other probes, you need to create a new vSwitch before you deploy the probe.

Create a vSwitch for vNetwork Distributed Switches

You can create a new vSwitch for the vNetwork Distributed Switches.

To create a vSwitch

1

(o T C) N G R (S

10
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In the vSphere Client or VI Client, select Home > Hosts and Clusters.

Select the destination host on which you want to install the probe.

Select Configuration > Networking > Add Networking Wizard.

In the Connection Type window, select the Virtual Machine option and click Next.
Deselect the check boxes for the NICs and click Next.

Name the vSwitch in the Network label text box, set the VLANID to 4095, and click Next.
Click Finish.

Deploy the AppSpeed probe in the Probe Installation window, selecting the new vSwitch for management
and monitoring.

NOTE If your management network is set to the fake vSwitch, and the Failed to obtain an IP address error
message is displayed after the probe deployment completes.

After the probe deployment completes, right-click the probe, select Edit Settings, and set the
management network and monitor network as required.

Restart the probe guest.

NOTE After the probe loads, it continues to appear as failed in the user interface; however, it functions
correctly.
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Create a Port Group

If you deploy a vNetwork Distributed Switch, it is recommended that you add a new port group.

To create a port group
1  In the vSphere Client or VI Client client, select Home > Networking.
2 Create a new port group for the vNetwork Distributed Switch:

a  Select the vNetwork Distributed Switch.

b  From the Basic Tasks list, create a new port group.

Configure Promiscuous Mode

You must configure the vNetwork Distributed Switch ports to work in promiscuous mode so that the
AppSpeed probe can monitor the switch.

To configure promiscuous mode for the port group.

1  In the vSphere Client or VI Client, select Home > Networking.

Right-click the corresponding port group in the vNetwork Distributed Switch and select Edit Settings.
Select Security.

Set the Promiscuous mode to Accept.

. B~ W N

Save your changes.

Configure the AppSpeed Probe to Monitor vNetwork Distributed Switches

Once the probe is deployed, you can configure the AppSpeed probe to monitor the distributed vSwitches.

To configure a probe to monitor a vNetwork distributed switch

1 Inthe vSphere Client or VI Client, select Home > Hosts and Clusters.

2 Right-click the corresponding port group in the distributed vSwitch and select Edit Settings.

3 Select the required network adapter.

4 From the Network drop-down menu, select the relevant port group (by default, dvPortgroupX).
5

Verify that both the Connected and Connect at power on check boxes are selected.

Configuring AppSpeed to Monitor Cisco Nexus 1000V Switches
If only Nexus 1000V switches are configured in the vCenter or if all other vSwitches are already being
monitored by other probes, you need to create a new vSwitch before you deploy the probe.
Create a vSwitch for Nexus 1000V Switches

You can create a new vSwitch for the Nexus 1000V switches.

To create a switch

1  In the vSphere Client or VI Client, select Home > Hosts and Clusters.

Select the destination host on which you want to install the probe.

Select Configuration > Networking > Add Networking Wizard.

In the Connection Type window, select the Virtual Machine option and click Next.
Deselect the check boxes for the NICs and click Next.

Name the vSwitch in the Network label text box, set the VLANID to 4095, and click Next.

N SN ke W N

Click Finish.
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8  Deploy the AppSpeed probe in the Probe Installation window, selecting the new vSwitch for management
and monitoring.

NOTE If your management network was set to the fake vSwitch, and the Failed to obtain an IP address
error message is displayed after the probe deployment completes.

9  After the probe deployment completes, right-click the probe, select Edit Settings, and set the
management network and monitor network as required.

10 Restart the probe guest.

NOTE After the probe loads, it continues to appear as failed in the user interface; however, it functions
correctly.

Configure Port Mirroring

You must configure port mirroring on the Cisco Nexus 1000V vSwitch ports so that the AppSpeed probe can
monitor a Nexus 1000V vSwitch.

To configure port mirroring
1  Set the server ports that you want to monitor as the source ports.
2 Set the unused ports as destination ports.

3 Enable port mirroring on the switch.

Configure the AppSpeed Probe to Monitor Cisco Nexus 1000V Switch

After the probe is deployed and set up, you can configure it to monitor the Nexus 1000V switches.

To configure the AppSpeed probe to monitor a distributed vSwitch

1  Inthe vSphere Client or VI Client, select Home > Hosts and Clusters.
2 Right-click the corresponding port group in the Nexus 1000V and select Edit Settings.

3 Select the required network adapter.

4 From the Network drop-down menu, select the relevant port with port mirroring configured.
5  Verify that both the Connected and Connect at power on check boxes are selected.

Managing SSL Keys

For AppSpeed to monitor traffic on HTTPS sites that incorporate SSL protection, you must configure the SSL
keys for each endpoint (IP address and port pair) where AppSpeed detects SSL traffic.

To view SSL key information
1  Click SSL Management in the navigation pane of the Administration module.
2 View the secure site endpoints for which AppSpeed cannot monitor traffic without a key.

B The Pending SSL Endpoints table lists the endpoints for which valid SSL keys are required, including
their IP addresses and ports. AppSpeed automatically identifies the SSL endpoints for which keys do
not exist.

®  The Monitored SSL Endpoints table lists the endpoints for which valid keys exist in AppSpeed,
including the respective server name, where available, and IP address and ports. AppSpeed monitors
traffic on these endpoints.

NOTE AppSpeed supports the configuration and monitoring of SSL keys for HTTPS sites only.
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Add an SSL Key

You can assign a key to a pending endpoint to enable AppSpeed to actively monitor its traffic.

To add an SSL key

1  Inthe SSL Management window, select the check boxes for the endpoints in the SSL Pending Endpoints
table and click Add/Update SSL key.

2 Browse to and open the key file.

The key is assigned to the selected endpoints. The endpoint moves from the SSL Pending Endpoints table
to the Monitored Endpoints table.

Update an SSL Key

You can update the SSL key assigned to an endpoint, for example, to replace an older key with a new one.

To update an SSL key:

1 In the SSL Management window;, select the check boxes for the endpoints in the Monitored Endpoints
table and click Add/Update SSL key.

2 Browse to and open the new key file.

The new key replaces the key previously assigned to the selected endpoints.

Extracting SSL Files

You can extract the SSL files from the Web server to obtain the SSL keys. The procedure varies according to the
type of Web server.

SSL Files from an Apache Server
You can extract the SSL files from an Apache server.
To extract SSL files from an Apache Server

1  Inthe Apache conf directory, open the http. conf file. The filename is either
/etc/httpd/conf.d/ssl.conf or /etc/httpd/conf/httpd.conf.

2 Locate the SSLCertificateKeyFile command on the SSL site.

3 Save a copy of the file that appears under SSLCertificateKeyFile as [cluster].key and transfer it to the
vSphere Client machine.

You can select and upload the key file to the AppSpeed server (see “Add an SSL Key” on page 32).
Extract SSL Files from a Microsoft lIS 6.0 Server
You can extract the SSL files from a Microsoft IIS 6.0 server.

To export the IIS key file

1  Select Start Programs > Administrative Tools > Internet Information System (IIS) Manager.
Expand the COMPUTERNAME (local computer) tree in the left pane, and then expand the Web Site tree.
Right-click Default Web Site and select Properties.

2

3

4  Select the Directory Security tab, and then select the Server Certificate button.

5  Select Next, select Export the current certificate to a PFX file, and select Next again.
6

Select a file for the exported certificate and key to be written, and select Next.
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7 Enter the password with which the key is to be encrypted.

During the export process, a password is requested to protect the key. If a password is assigned, remember
this password. This password is required when importing the key into AppSpeed.

8  Re-enter the password in the Confirm Password text box.

9  Select Finish.
The PFX file should be transferred to the vSphere Client machine and uploaded to the AppSpeed server
(see “Add an SSL Key” on page 32).

Extract SSL Files from a Microsoft IIS 7.0 Server

This section describes how to extract the SSL files from a Microsoft IIS 7.0 server.

To export the IIS 7.0 key file
1  Select Start Programs > Administrative Tools > Internet Information System (IIS) Manager.

2 Expand the COMPUTERNAME (local computer) tree in the left pane and then double-click the Server
Certificates icon in the middle pane.

3  Right-click the certificate and select Export.
A PFX file is created.

During the export process, a password is requested to protect the key. If a password is assigned, remember
this password. This password is required when importing the key into AppSpeed.

The PFX file should be transferred to the vSphere Client machine and uploaded to the AppSpeed server
(see “Add an SSL Key” on page 32).

Managing AppSpeed Licenses

You must have an AppSpeed license to monitor servers.

To view existing licenses

1  Click the Administration tab at the top of the AppSpeed user interface to display the Administration
module.

2 Inthe navigation pane, click Licensing to display the License page.

The total number of licensed processors (all licenses combined) and the number of monitored processors
are displayed at the top of the page.

The following details are displayed for existing licenses:
B Key: The license key string.

B Processors: The maximum number of physical chips on physical hosts that have virtual machines
monitored by AppSpeed.

m  Expiration Date: The date on which the license will expire.
B Time to Expiration: The number of days left before the license expires.
®m  Validated: Indicates whether or not the license key has been validated.

Expired licenses appear in red.
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Add a License

You can add additional licenses, for example, if you want to implement AppSpeed monitoring on additional
servers not covered by existing licenses.

To add a license
1 Inthe License page, click Add License.
2 Enter the license key provided by VMware in the text box and click OK.

NOTE If the license key string is not valid, an error message is displayed immediately above the license
key list. Check the license key and try again.

Viewing License Details

You can view the details of an existing license, including the allowed number of servers, the date the license
was issued, the date the license is scheduled to expire, and the number of days left until that expiry date.

To view the license details
1  Inthe License page, select a license key and click View License.

2 Click OK to return to the License page.

Remove a License

You can remove an existing AppSpeed license.

NOTE If you remove a valid license, the number of allowed processors decreases accordingly.

To remove a license
1  Inthe License page, select a license key and click Remove License.

2 When prompted to confirm the deletion, click OK. The license is removed. If the license had not yet
expired, the number of allowed processors decreases accordingly.
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You can monitor Service Level Agreement (SLA) compliance based on the performance of applications and
transactions. AppSpeed monitors these latency and error thresholds for transactions. When a threshold is
exceeded, AppSpeed generates an event.

You can manually monitor events or you can configure AppSpeed to send email notifications whenever an
event is generated.

This chapter includes the following topics:

B “SLA States” on page 35

B “Configuring SLA Thresholds” on page 35
B “Configure Email Notifications” on page 38

B “Viewing Events” on page 39

SLA States

AppSpeed uses state changes to generate events. The state of a transaction is based on its compliance to the
defined latency and error thresholds.

The state of an application reflects the worst state of any of its transactions. For example, if the state of all the
transactions is OK, the state of the application is OK. If the state of any transaction is Not Available, the
application state is Not Available.

NOTE You can view the real-time states for all applications or for the transactions of a selected application.
See “View Real-Time States” on page 15.

Configuring SLA Thresholds

You can define the levels at which state changes occur in response to fluctuations in performance as measured
by latency and the percentage of errors. You configure thresholds per transaction.

When a performance level exceeds a defined threshold, a change in state occurs. Specific thresholds are
defined for each state based on the degree of an application’s compliance with or deviation from target SLA
levels. The transition between states occurs based on the thresholds defined for warning, SLA violation, and
unavailable states for the given transaction.

You can enable or disable performance monitoring per application or per transaction. See “Enable or Disable
SLA Monitoring of Transactions” on page 36.
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View Thresholds and Monitoring Settings

You can view the thresholds and SLA monitoring settings.

To view threshold and monitoring settings
1 Inan application view, click Threshold Settings on the page selection bar.
2 If SLA Monitoring is enabled, you can view the monitored transactions
A separate entry appears for each transaction, including;:
m  Modified: If a change is made in the settings for the transaction but not applied, a flag icon |*® appears.

B Name: The name of the transaction and an icon indicating its state. Separate rows appear for
Latency @ and Errors ¢ immediately below each transaction name.

B Monitor: An On or Off icon indicates whether AppSpeed monitors thresholds and generates events
for the transaction.

B Warning: The threshold for the respective warning state, if defined.

B SLA: The threshold for the respective SLA violation state, if defined.

®  Unavailable: The threshold for the respective unavailable state, if defined.
B Average: The average performance level for the selected time frame.

B Updated: The date and time of the last threshold settings update.

SLA Monitoring

You can enable or disable SLA monitoring per application or per transaction. When disabled, thresholds are
not monitored and events are not generated for state changes.
Enable or Disable SLA Monitoring of an Application

If you enable SLA monitoring for an application, it is enabled for the application and for all of its transactions.
If you disable SLA monitoring, you cannot set SLA thresholds for its transactions.

To enable SLA monitoring for an application
1 In the Threshold Settings page for the application, select SLA Monitoring Enabled.

2 From the Sensitivity drop-down menu, select the sensitivity of state changes in response to detected
deviations in performance levels, based on the number of hits and their persistence over time.

B High: Trigger a state change within a minute of detecting the onset of deviations.
B Medium: Trigger a state change after detecting the onset of deviations that persist for 5 minutes or longer.
B Low: Trigger a state after detecting the onset of deviations that persist for 30 minutes or longer.

3 (Optional) Click Go to Mail Notification Settings to configure AppSpeed to send email notifications
regarding state changes (see “Configure Email Notifications” on page 38).

To disable SLA monitoring for an application

In the Threshold Settings page for the application, select SLA Monitoring Disabled.

Enable or Disable SLA Monitoring of Transactions

You can enable or disable SLA monitoring for specific transactions. To monitor a transaction, SLA monitoring
must be enabled for the application to which it belongs.

Disabling SLA monitoring does not remove any saved threshold settings, however the transaction is no longer
monitored for changes in performance levels based on those thresholds.

NOTE If SLA monitoring is disabled for an application, you cannot enable monitoring of its transactions.
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To enable or disable monitoring for a specific transaction

In the Threshold Settings table, click the On or Off icon in the row for the performance threshold.

To enable or disable monitoring for all transactions:

On the Threshold Settings toolbar, click Monitor All or Unmonitor AlL

Setting Thresholds

The threshold value determines the performance level that triggers a change in the state of a transaction or
application. For each transaction, you can define thresholds for latency and errors. You can specify threshold
values or have AppSpeed suggest values based on performance trends over time.

Define Thresholds

You can set the SLA thresholds for latency and errors for a specific transaction.

To manually define thresholds

1 In the Threshold Settings page for the application, select the row for the performance threshold
(Latency or Errors).

The threshold settings are shown in the Threshold pane below the table. The transaction’s performance
relative to the thresholds is indicated on the accompanying graph. The thresholds are indicated by
color-coded lines. A black line indicates the performance trend for the defined time period.

2 Type the threshold value in the state field (Warning, SLA, or Unavailable).
When the threshold value is exceeded, the transaction status changes to the selected state.

The threshold line on the graph is adjusted according to your setting so that you can view the performance
data relative to the proposed threshold.

NOTE To revert to the previously saved values, click Revert.

3 When you have completed setting the thresholds, click Update Table.
The values are updated in the Threshold Settings table.
4  Click Apply Changes to accept the changes.

Use AppSpeed Threshold Suggestions

You can have AppSpeed suggest threshold values based on performance trends over time. AppSpeed can
suggest values for all thresholds for all application transactions or only for those thresholds for which no
values exist.

If you suggest threshold settings for all transactions, you can still disable monitoring for specific transactions.

To suggest values for all thresholds
1  Inthe Threshold Settings page for the application, click {ix Suggest for All on the toolbar.
A progress bar is displayed while the process is performed, which might take several minutes.

When the process is complete, any previously set values in the Threshold Settings table are overwritten
by the suggested values. A flag icon |"™ next to the transaction name indicates that it is overwritten.

NOTE To revert to the previously saved values, click Revert All.

2 Toedit a suggested value for a specific transaction, select the row for the performance threshold (Latency
or Errors) and edit the value in the corresponding state field (Warning, SLA, or Unavailable), as described
in “Define Thresholds” on page 37.

3  Click Apply Changes to the save the values in the Threshold Settings table.
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To suggest values for undefined thresholds

1

In the Threshold Settings page for the application, click fis Suggest for Undefined on the toolbar.
A progress bar is displayed while the process is performed, which might take several minutes.

When the process is complete, any previously set values in the Threshold Settings table are overwritten
by the suggested values. A flag icon |"™ next to the transaction name indicates that it is overwritten.

NOTE To revert to the previously saved values, click Revert All.

To edit a suggested value for a specific transaction, select the row for the performance threshold (Latency
or Errors) and edit the value in the corresponding state field (Warning, SLA, or Unavailable), as described
in “Define Thresholds” on page 37.

Click Apply Changes to the save the values in the Threshold Settings table.

Configure Email Notifications

38

You can configure AppSpeed to send email notifications regarding events to one or more email addresses.
An email notification includes a one line summary of each generated event. The notification settings are
configured globally and are identical for all monitored applications.

To configure email notifications

1

7
8

In the navigation pane of the Administration module, click Mail Notification Settings.

You can also click Go to Mail Notification Settings in the application Threshold Settings page.

Select the Send mail notifications for events check box.

In the Recipient addresses text box, type the email address to which to send notifications and click Add.
You can add additional email addresses as needed.

In the SMTP server section, select how to route email messages:

If you select Forward all mails to the following smart host, enter the address of the smart host in the
adjacent text box.

In the Outgoing Mail Definitions section, configure the following parameters:
B Sender Account: The email account from which event notification messages are to be sent.
B Mail Subject: The subject text to appear in event notifications.

B Interval between Mails: The interval, in seconds, between the sending event notifications. During
the interval, event notifications are accumulated and then sent as a single email notification.

In the DNS Server section, type the preferred and alternate DNS server details in the respective text boxes
or select the Acquire Automatically check box.

(Optional) Click Sent test mail to verify the accuracy of the email addresses.

Click Apply.

To remove an email address from the notifications list

1
2
3

In the navigation pane of the Administration module, click Mail Notification Settings.
In the Recipient addresses list, select the email address that you want to remove and click Remove.

Click Apply.
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Enable or Disable Event Notifications

Disabling event notifications allows you to temporarily suspend email notifications, without affecting the
notification configuration settings.

To enable or disable notifications
1  In the navigation pane of the Administration module, click Mail Notification Settings.

2 Select or clear the Send mail notifications for events check box and click Apply.

Viewing Events

The Events List includes the events generated in the specified time period. Table 5-1 describes the parameters
included in the Events List.

Table 5-1. Event List Parameters

Parameter Description

ID Event ID

Time Time when the event was generated

Type Type of object for which the event was generated (transaction or application)
Name Name of the object for which the event was generated

Event Type Type of event: Latency or Error percentage

From State State of the object before the event was generated

To State Updated state of the object for which the event was generated.

When the root directory is selected in the navigation pane, only application events are displayed in the Events
List tab.

View Events List

1  To view the events for a specific application, select the application on the AppSpeed inventory tree and
click Events on the page selection bar.

2 To move forward or backward within the specified time period, click Next Day or Previous Day,
respectively.

3  To hide transaction-specific events, deselect the Show Transactions check box.
To display the transaction-specific events, select the Show Transactions check box.

4  To view events per transaction, select the transaction in an Application view and click Events on the page
selection bar.

View Event Details

You can view the details of a single event, including the key performance indicators of the object for which the
event was generated. This information includes the time when the event occurred and performance indicators.

For a description of the performance indicators, see “Performance Indicators” on page 17.

To view event details
In the Events List page, double-click the event.

When applicable, links to suggested actions are displayed in the Next Steps pane.
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Delete Events

You can delete events from the Events List at any time.

To delete events

In the Events List page, select the events and click Delete.

40

VMware, Inc.



Upgrading AppSpeed

If a new version of AppSpeed is available, you can upgrade to that version.
This chapter includes the following topics:
B “Overview of the Upgrade Process” on page 41

B “Upgrade AppSpeed” on page 41

Overview of the Upgrade Process

The AppSpeed upgrade process uses an ISO image and is fully automated. The ISO image is provided by
VMware.

You upgrade AppSpeed by connecting the ISO image with the new version to the AppSpeed server machine
and running a command-line interface (CLI) command. The CLI command performs the following actions:

1  Upgrades the AppSpeed server and performs two sequential reboots.

2 Sets up the AppSpeed server with the new version, keeping all configurations and monitoring data of the
previous version.

3  Creates a recovery virtual machine snapshot on the AppSpeed server machine to which you can revert at
any time.

4  Creates a backup copy of all the configuration and monitoring data to enable the upgrade to restore
existing data.

5 Distributes the upgraded version to all probes.

You can observe the progress of the AppSpeed server upgrade and set up processes from the console. You can
observe the redeployment of the probes in the AppSpeed user interface.

Upgrade AppSpeed

You upgrade AppSpeed version using the ISO image provided by VMware.

To upgrade AppSpeed

1  Save the ISO file provided by VMware to a location on your network.

2 In the vSphere Client or VI Client, connect the AppSpeed server to the ISO file.
a  Select the AppSpeed server machine in the inventory tree.
b Click Connect CD/DVD and select Connect to ISO image from the drop-down menu.
¢ Browse to the location of the ISO file.

3 Log in to the AppSpeed server console as the console user.

4  From the default console shell, run the command upgrade_AppSpeed.
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Press Enter to run the upgrade script.

The upgrade process reboots the AppSpeed server and recreates all AppSpeed probes. This can take up
to 20 minutes.

NOTE If an error occurs during the script execution, an error message appears indicating the nature of
the error.

After the AppSpeed server boots from the ISO image, it continues the upgrade process. This process can
take up to one hour.

When the process is complete, the ISO image reboots the system and starts a second upgrade script.
A message appears indicating that the AppSpeed server upgrade is complete.

You are prompted to disconnect the ISO file.

Disconnect the ISO file in the Client.

The script recreates the probes in the new version. You can monitor the redeployment process from the
AppSpeed Probes Deployment window.

Verify the redeployment of the probes.
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Troubleshooting

If you encounter problems when using AppSpeed, use this troubleshooting information to try and resolve the
problem.

This chapter includes the following topics:

B “AppSpeed Setup Errors” on page 43

B “AppSpeed User Interface Loading Problems” on page 44
B “General Errors While Using AppSpeed” on page 46

AppSpeed Setup Errors
If you have problems while setting up AppSpeed, try these troubleshooting suggestions.
Problem
Setup fails and the following error message appears:
Connection timed out. Verify the vCenter address and try again.

Cause

You entered an incorrect vCenter Server IP address during setup.

Solution

1 Verify the accuracy of the vCenter Server IP address.
2 Run setup again and enter the correct IP address.
Problem

Setup fails and the following error message appears:

Connection timed out. Verify the vCenter address and try again.

Cause

The vCenter HTTPS Web Service port is not configured to work with the default port 443.

Solution

1 Check the vCenter Web Service port.

2 Run setup again and enter <vCenter_IP>:<HTTPS_Port> in the vCenter parameters section.
Problem

Setup fails and the following error message appears:

Connection timed out. Verify the vCenter address and try again.
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Cause

The vCenter HTTPS Web Service port is blocked to traffic between the AppSpeed server and vCenter Server.

Solution

1 Verify with IT that the vCenter HTTPS Web Service port on the firewall is open from the AppSpeed server
to vCenter Server.

2 Run setup again.

3 If the problem persists, try running Telnet to the vCenter IP with the vCenter HTTPS Web Service
configured to port 443 to verify that the port is open.

Problem
The following error message appears:

The remote server returned an error: Server Unavailable

Cause

The vSphere Client or VI Client uses HTTP to download the AppSpeed user interface from the AppSpeed
server. If the firewall between the vSphere Client or VI Client and the AppSpeed server is closed for port 80,
the download fails.

Solution
1 Verify that port 80 is open on the firewall.

2 If the problem persists, log in to the AppSpeed server virtual machine as the console user and run
restart_AppSpeed.

Problem
The following error message appears:

The application failed to initialize properly, click OK to terminate the application.

Cause

A problem occurred in the AppSpeed server.
Solution
1 Login to the AppSpeed server virtual machine as the console user.

2 From the console, run restart_AppSpeed.

AppSpeed User Interface Loading Problems
If you have problems loading the AppSpeed user interface, try these troubleshooting suggestions.
Problem
After clicking the AppSpeed plug-in Download and Install link, the following message appears:
The remote server returned an error: (404) Not Found.

Cause

The AppSpeed plug-in fails to install if vCenter is not configured to work with port 80.

Solution

1  Manually download the setup.exe file from:
http://<vCenter_IP>:<HTTPS_Port>/AppSpeed/static/setup.exe

2 Run the setup.exe file. (Close the vCenter before performing the installation)
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3 On the machine running the vCenter Client, go to C:\Program
Files\VMware\Infrastructure\Virtual Infrastructure Client\Plugins\AppSpeed.

4 Open the Settings.config file in a text editor.

5 Replace the line <!-—ConductorURL>http://<hostname>/</ConductorURL-—> with the line:
<ConductorURL> http://<vCenter_IP>:<HTTPS_Port>/AppSpeed/</ConductorURL>.

6  Replace the line <VCProxyNamespace>AppSpeed</VCProxyNamespace> with
<!——VCProxyNamespace>AppSpeed</VCProxyNamespace——>.

For example, for vCenter 1.2.3.4 and port 8080, use:
<ConductorURL>http://1.2.3.4:8080/AppSpeed/</ConductorURL.

7  Save and close the file.

8  Restart the vSphere Client or VI Client and enable the AppSpeed plug-in in the Plugin tab.

Problem

You click the AppSpeed icon in the vSphere Client or VI Client, but the AppSpeed view does not load.

Cause

A connection to the server cannot be established or there is an issue with proxy settings. This type of error is
usually preceded by one of the following messages: Received a connectivity error or URL Error received.

Solution

1 Login to the AppSpeed server virtual machine as the console user.
From the console, run restart_AppSpeed.
Verify with IT that port 80 is open on the firewall.

2

3

4  Restart the vSphere Client or VI Client.

5  Wait a few minutes for the AppSpeed user interface to load.
6

If the user interface still does not load, reinstall the user interface from the plug-in window.

Problem
The following error appears in the user interface:

Unable to communicate with AppSpeed server: failed to download Ul module from http://<vCenter address>/AppSpeed>,
consult your system administrator.

Cause

An HTTP connection to the AppSpeed server is refused due to certificate authorization issues.
Solution

1 InInternet Explorer or Firefox, go to http://<AppSpeed server IP>.

A message appears indicating that the server’s certificate must be approved before the machine allows
HTTP connections.

2 Approve the certificate using the Web browser.
3 Restart the VI Client.
4  Click the AppSpeed button.
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5 If the problem persists, go to http://<AppSpeed server_ip>/AppSpeed/static/setup.exe and download
setup.exe from the AppSpeed Brain.

If you succeed, the server is accessible.

6  If the problem persists and the 503 Service Unavailable message appears, log in to the AppSpeed server
virtual machine as the console user and run restart_AppSpeed from the console.

Problem

The user interface cannot connect to AppSpeed.

Cause

Storage used by the AppSpeed server was disconnected for a while causing the file system to respond as a
read-only file system.

Verify the cause by logging into the console on the AppSpeed virtual machine and running commands such
as start_AppSpeed or restart_AppSpeed. The resulting error message will indicate that the file system is
read-only. For example, a message similar to the following one might appear:

OS Error: [Error 30] Read-only file system: "twistd.pid’

Solution
1  Validate that the storage is up.

2 From the vSphere Client or VI client, reboot the AppSpeed server’s virtual machine to reinitialize the file
system.

General Errors While Using AppSpeed

48

If you have problems while using AppSpeed, try these troubleshooting suggestions.
Problem

One of my virtual machines is not in the AppSpeed Inventory Tree.

Cause

No AppSpeed probe is configured to monitor the virtual machine.

Solution

1 Verify that an AppSpeed probe is running and located together with the virtual machine on the same host.

2 In the Host networking configuration, verify that the AppSpeed probe is connected to the vSwitch that
the virtual machine uses for traffic handling.

Cause

The virtual machine is not mapped due to a low volume of traffic.
Solution
1  In the Analysis module, select Applications and Servers in the inventory tree.
2 Click Unmapped Traffic on the page selection bar.
3  Click the Servers tab and search for the virtual machine.
A low number of hits indicates that the virtual machine is not yet mapped.

Cause

The virtual machine is not displayed because SSL private keys need to be loaded.
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Solution

1 Inthe user interface, select SSL Management in the Administration module and verify that the server
appears on the list.

2 If the server is on the list, load the corresponding private keys.
See “Managing SSL Keys” on page 31.
Problem
I do not see my application in the AppSpeed user interface.
Solution
1  In the Analysis module, select Applications and Servers in the inventory tree.
2 Select Unmapped Traffic on the page selection bar.
3  Click the Servers tab, and search for the server that runs the application under the relevant protocol.

A low number of hits indicates that the application is not yet mapped. In the Transactions tab, you can
see any transactions that are not mapped to an application due to a low number of hits.

4  If the server is not discovered, verify that AppSpeed probe is running and connected to the same vSwitch
that the server uses for traffic handling.
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